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Abstract

This thesis performs an initial exploration of the topic of avatars with disability. Therefore some
related topics are explored, namely VR, avatars and the concepts of immersion, presence and
embodiment. Further a survey is conducted to gauge peoples opinion on and thoughts about avatars
with disability. Finally a study is conceptualised which aims to find how comfortable disabled
people are with using avatars with disability and which reactions they get from others. The survey
shows that participants were not opposed to the idea of providing avatars with disability for those
who want them however they were more hesitant when asked if they themselves would use such
avatars.
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1 Introduction

Virtual environments have become a bigger and bigger part of everyday life, be it for video games
or meeting software. These environments by their nature of being virtual, require users to be
represented by a proxy, an avatar. Avatars are most often digital representations of a user used
inside virtual environments and based on the used definition range from a simple name to a full 3D
model. For the topic of avatars with disability only avatars which can show signs of disability are
important; for this thesis these are exclusively 3D modeled avatars.

There exists research about the effects an avatar has on the user [YB07] [SPZS16] [PS19] [CT10]
[LSG+16] and on avatar design. Most work however focused on non-disabled avatars. Some papers
examined disabled avatars but only in a very limited context, for example rehabilitation purposes
[SB05]. But there exists no research regarding the everyday use of avatars with disability which
this thesis is doing a first exploration into. To this extend this thesis is going to take a look at
some thematically related work, perform a survey investigating peoples thoughts on avatars with
disability and prepare a follow-up study in which participants will use avatars with disability. This
topic seems important considering that the WHO estimated in 2011 that about one billion people
worldwide live with some form of disability [WHO11] and there is the possibility that some of these
people would like to be represented by an avatar with disability. It must therefore be explored if this
is the case and what requirements people have for these avatars.

1.1 Virtual Reality

When it comes to avatars one very interesting area is VR and also potentially augmented reality
(AR), however this thesis focuses only on VR. To use VR one needs an head mounted display (HMD)
and at least two tracking points on their hands which normally come in the form of controllers;
full body tracking is possible but optional. VR is also normally experienced from a first person
perspective. This makes VR a very immersive experience with a great sense of presence, according
to the definitions by Slater [Sla03]. These properties allow VR to essentially replace reality [MK94].
Because of this users can fully embody their avatar, more or less replacing their real body with the
avatar’s body [SPES08]. Therefore users must feel comfortable in their virtual body. It is possible
that there are people who would feel more comfortable in an avatar with disability than in one
without, but for the most part their only option is a non-disabled avatar. Hence it is necessary to
find if there is a demand for avatars with disability. To this extend this thesis conducts a survey to
gather peoples thoughts and opinions on avatars with disability.

Additionally because of the Proteus effect [YB07] an avatar can influence its users behaviour
[BGS13]. The Proteus effect is especially prevalent in VR because of its immersive nature. This
means an avatar with disability can make its user feel more disabled even if they are not and an
avatar without disability in turn can make its user feel less disabled. This was already explored in
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1 Introduction

part before by Guo et al. [GSQ14b] where people with motor impairments performed better in a
balancing experiment when using a non-disabled avatar. However this thesis will not examine this
further.

1.2 Disability

As already mentioned about one billion people worldwide are estimated to have some form of
disability [WHO11]. For a long time disability was defined as having a body which is not normal.
Some disabled people took offense with this as this presented disability as something treatable
which should be avoided at all costs. They tried replacing it with a new definition under which a
disabled person is someone who is not accommodated by society, e.g. no ramps for wheelchair
users. However as Donoghue [Don03] reports the success of this redefinition seems to be limited.
Even the WHO [WHO11] used a slight variation of the first definition, defining anyone as disabled
who is not normal within their respective community. This thesis also uses the first definition as it
is concerned with avatars looking different from the norm. Therefore this thesis considers a person
disabled if their body involuntarily looks different from the norm, e.g. being amputated or using a
wheelchair, and by extension also avatars. Above it was mentioned that about one billion people
worldwide are disabled. However from the WHO [WHO11] report it is not apparent how many of
these people fall in this subcategory of looking different. But considering how huge this number is
it is likely for this subcategory to also be big.

Being disabled comes with a certain amount of prejudice [Gru16]. It is therefore of interest how the
people who use an avatar with disability feel while using it and how others react to these disabled
avatars. To this extend this thesis prepares a follow-up study which investigates this further.
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2 Background

First this thesis presents the background information it builds upon. Hence this section shortly
touches on what VR and AR are before exploring the concepts of immersion and presence and how
they relate to VR. This sections also talks shortly about disabilities in general and what disabilities
seem worth to consider for this work.

2.1 Virtual and Augmented Reality

The “virtuality continuum” by Milgram and Kishino [MK94] depicted in Figure 2.1 has been
used for nearly 30 years now to classify virtual realities based on how many real and non-real
(virtual) objects can be perceived. Although both AR and VR utilise an HMD their position on
this continuum is very different. With AR the user still sees the real world around them but with
additional virtual objects overlayed on top of it. This places AR more towards the real end of the
continuum. The HMD for VR on the other hand completely blocks the user’s view of the real world
enabling VR to only show the user virtual objects. This places VR close towards the virtual end of
the continuum. It is not a “virtual environment” since the user still experiences objects from the
real world via senses other than sight.

Slater [Sla03] argues that an experience is more immersive the more it occupies a user’s senses.
Since the HMD for VR completely takes up a user’s visual system it is therefore more immersive
than most other display technologies. Because the goal of VR has always been to create a human
computer interface which is indistinguishable from reality [ZCG98] it needs to be as immersive as
possible because only than can a user completely forget the world around them and become truly
present in the virtual world.

As VR technology advances further it is incorporated into more and new applications. The
most prevalent use outside of scientific research is certainly the entertainment industry. VR is
used for a new gaming experience, to meet others in social VR and to host completely virtual
events like concerts among other things. It is even used for more serious use-cases like holding

Real
Environment

Augmented
Reality (AR)

Virtual
Reality (VR)

Virtual
Environment

Mixed Reality (MR)

Figure 2.1: Virtuality Continuum

13



2 Background

business meetings1, to visualize data [BL+92], mechanical design [KV00], the military [ZMMD05],
medicine [ZS97] and can be used for remote training for example through means of motion guidance
[YAM+20]. Uses for education have also been explored [VK08] [AWB+97] even for special needs
institutions [RSH05]. In the context of disability VR can be used to help with for example therapy
or rehabilitation [SB05] [VDP+21].

2.1.1 Immersion

Immersion and presence are terms regularly used when talking about VR. Although everyone
seems to intuitively understand what these terms mean, it is rather hard to obtain a concrete
definition. Patrick et al. [PCS+00] described immersion as the “feeling of isolation from the real
world” [PCS+00, p.2] while doing an activity. As “feeling isolated” is a completely subjective
measure Slater et al. [SLUK96] provided another definition of immersion as something quantifiable
and measurable. For them immersion is how much someone engages with something and it can
be improved by occupying more of a users sensory input. In their work they focused on virtual
environments so their terminology is mostly computer related. Therefore ones immersion is higher
the more of ones field of view is taken up by displays, the less external sound they hear and the
more directional the sound is. Additionally they stated that all actions should produce the expected
effect. An example they provided is that turning ones head should result in one’s view turning
accordingly.

Brown and Cairns [BC04] did not provide a definition of immersion but instead they identified
several barriers that must be overcome for a user to feel total immersion. First one must be engaged
with whatever it is they are doing. This manifests as one enjoying and it being easy for them to
engage with what they are doing. Problems for this can for example manifest as difficult game
controls [BC04]. Brown and Cairns also stated that doing something for a prolonged amount of
time increases one’s engagement with that activity, potentially even to a point at which one looses
track of time. The second barrier towards total immersion is the level of engrossment someone
feels towards their activity. This manifests as the activity controlling ones emotions, like feeling
happiness or sadness based on what is happening. It also has the ability to lead to one forgetting
what they are actually doing in real life and based on the specific activity completely suspending
their disbelief in what is happening in the virtual world. One interviewee of Brown and Cairns
described engrossment as a “Zen-like state where your hands just seem to know what to do” [BC04,
p.3]. The last barrier towards total immersion is presence. One can only be totally immersed in
what they are doing when they feel presence.

In conclusion immersion is probably best described as someones disconnect from reality. An
immersed person might for example not notice the passage of time or other people around them.
This is, as long as barriers like those described by Brown and Cairns [BC04] remain removed. To
achieve this it seems to be beneficial to block out as much of the real world like described by Slater
et al. [SLUK96].

1www.meetinvr.com
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2.1.2 Presence

Presence was described by Patrick et al. [PCS+00] as how much someone feels like they are
somewhere else then their physical body actually is. Slater et al. [SLUK96] support this definition
but extend it by stating that presence influences the behaviour of the person experiencing it [Sla03]
[SLUK96]. Slater also stated that “[p]resence is a human reaction to immersion” [Sla03, p.2].
Through this they support the immersion definition by Brown and Cairns [BC04]. Additionally the
definition by Brown and Cairns suggests that one must reach a certain level of immersion in order
to experience the effect of presence.

In their review Lee [Lee04] looked at existing definitions of presence and from there create their
own. They defined three different types of presence: physical, social and self. Physical presence is
experienced when one interacts with a space, e.g. by walking around or picking up objects. One
experiences social presence when interacting with other actors, be it computer or user controlled.
Finally self presence is the experience of being someone else.

All of these definitions together suggest that presence is the feeling of being somewhere else than
one currently is. This also includes the ability to interact with this other place and actors within it.

2.1.3 Embodiment

Embodiment describes the act of embodying someone2 with embodying meaning 1) “to give a
body to (a spirit)” or 2) “to become a body or part of a body” (Mariam Webster3). A synonym
for embodiment is avatar1 which probably stems from the fact that avatars are the embodiment of
Hindu deities.

One of the first work on embodiment is the rubber hand illusion by Botvinick and Cohen [BC98].
Here the participants left hand is hidden from sight and replaced with a rubber replica. The
participants left hand and the rubber replica are then both stimulated with a brush synchronously
while the participants focuses on the rubber replica. After some time the participants report that
they feel the brush on the rubber hand instead of their own, they are experiencing body ownership
of the rubber hand [WGR+18]. The illusion breaks if there is a slight asynchronousity between the
two brushes. Ĳsselsteĳn et al. [IKH06] found that the rubber hand illusion also works when the
hand is only projected. Slater et al. [SPES08] then found that the rubber hand illusion also works in
VR. Instead of having a rubber hand or the projection thereof in front of the participant, they were
shown a 3D model inside a VR-environment. Because of this it is possible to extend the rubber
hand illusion to VR; the participants are experiencing virtual body ownership [WGR+18].

Since humans can only physically embody their own body Kilteni et al. [KGS12] describe this effect
in VR as Sense of Embodiment (SoE), meaning that the user only feels like they embody another
body. In order to experience SoE Kilteni et al. identified three properties that need to be fulfilled.
First is the sense of self-location. This describes the feeling of being physically located somewhere
in space. It is related to the feeling of presence in that to feel presence in VR one has to feel located
inside a virtual environment. The difference between these two is that in order to feel presence one

2www.merriam-webster.com/dictionary/embodiment
3www.merriam-webster.com/dictionary/embodying
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2 Background

needs to feel like they are somewhere specific e.g. in a concert hall and can interact with that place,
while in order to feel self-located one only needs to feel like they are somewhere and there is no
need to be able to interact with this place. Next is the sense of agency. This describes that when
one does something it should result in the expected outcome. For example moving ones arm should
also move the arm of ones avatar. This also helps with feeling SoE towards the avatar. However
a mismatch or a to long delay can stop the user from feeling SoE [BC98] [KGS12]. Third is the
sense of body-ownership. This describes the experience of taking ownership of a body or part of
a body. The benefit of VR is that one embodies an avatar and therefore feels SoE towards said
avatar [Con14] [SSSB10] and since an avatar is purely digital it can easily be modified. This is
possible because the movements of an avatar in VR can be made to directly mirror the movements
of a user.

2.1.4 Benefits of Embodiment and Presence

An effect of feeling SoE is that a user experiences the Proteus effect [YB07] which is the influence
ones avatar can have on ones behaviour and self-image. For example participants with attractive
avatars interact more intimately and participants with taller avatars act more confident [YB07]. In
another study [KBS13] the authors found that the self-avatar influences how people played the
drums. The self-avatars skin colour can change ones implicit racial bias [PSAS13] and having
a small self-avatar can change how the size of objects is perceived among other things [BGS13].
This clearly demonstrates that the appearance of ones avatar is not purely cosmetic but can have a
real impact on ones behaviour inside a virtual environment. This is helped by a strong feeling of
presence which makes an experience feel more real for the user [MTK+20]. And increasing the
feeling of social presence leads to better interactions between users [SS15]. Guo et al. [GSQ14b]
found that a stronger feeling of presence increased the confidence, motor impaired participants had
in their ability to walk inside a virtual environment.

One way to increase presence is to give the user a virtual body they can embody. It is even better
if this is done inside a VR-environment and if the user has a first person perspective [YAM+20]
[PS19] [GSQ14b]. Being able to personalize an avatar also improves the user’s feeling of presence
[WGR+18] [LSG+16]. It is also beneficial to couple the user’s body as tightly with the applications
interface as possible, as this increases the user’s immersion into the virtual world and by that
increases their presence in it [KPB14]. And Yoon et al. [YKL+19] found that social presence
increases when the interaction partner has a fully modeled avatar.

2.2 Disabilities Considered

For a long time the working definition of disability in the literature was the medical model in
which disability was a bodily problem of an individual [FG07]. Disability was seen as something
treatable and treatments focused on rehabilitating individuals back into society. This was seen as a
discrimination against people with disability and gave rise to a new definition focused on the society
called “ableism”. Ableism is “a network of beliefs, processes and practices that produces a particular
kind of self and body (the corporeal standard) that is projected as the perfect, species-typical
and therefore essential and fully human. Disability then, is cast as a diminished state of being
human” [Cam01, p.44]. Under this new model a person is only disabled because society does not
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accommodate them. However the acceptance of this new definition is questionable [Don03]. In
their report the WHO did also use the medical definition and with this definition estimate that
around one billion people worldwide are disabled in one way or another [WHO11]. They also state
that almost every person on earth will be disabled at some point in their life be it permanent or
only temporary. Therefore it is absolutely necessary to consider how people with disability want to
represent themselves in an online environment in which they act as themselves.

For the topic of avatars with disability it seems not constructive to consider all disabilities. Some
disabilities have no or optional outside identifiers, e.g. ADHD or diabetes. Other disabilities only
impact how a person moves, e.g. spasticity or a stiff knee, which at least in VR can already be
replicated via full-body tracking. The disabilities which should be examined further are those
which change the appearance of the body, e.g. amputation or paraplegia. However this thesis is not
concerned with the actual disabilities but only with their visible signs, e.g. missing a limb or sitting
in a wheelchair. For the survey in Section 4.2 there were no restrictions on which disabilities were
considered, in the study in Chapter 6 the disabilities considered are limited to those which require
one or more of the following: a wheelchair, a walker, a walking cane.
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3 Related Work

This next section takes a look at different definitions of avatars to create a working definition for
this thesis and finds some benefits of having an embodiable avatar. Additionally the concept of VR
for people with disability is touched on.

3.1 Self Avatars

Definitions of what an avatar is vary widely across the literature as found by Nowak and Fox [NF18].
In their work they looked at different definitions of avatars and found commonalities and differences
between them. The first commonality is the term “avatar” which is derived from Hinduism in
which it is a “human embodiment of a deity or a spirit” [NF18, p.33] which allows the deity to walk
on the earth as and interact with humans. Next is that avatars are a digital representation of a user
inside a digital space. And lastly they found avatars enable users to “experience and interact within
the spaces of digitally mediated worlds” [NF18, p.33], which includes other users. A big difference
Nowak and Fox identified is the level of digital representation needed for that representation to
be considered an avatar. For some definitions any digital representation is an avatar, for others
the representation must be visual and from within the current digital space. Another difference is
whether only humans can have avatars or if characters controlled by a computer also qualify as
avatars. The last difference they mentioned is that many definitions are too specialised probably
because of which digital space was studied in that particular research. Finally Nowak and Fox
provided their own definition of what an avatar is based on their review. To them an avatar is “a
digital representation of a human user that facilitates interaction with other users, entities, or the
environment” [NF18, p.34]. They did not include that an avatar must be a visual representation of a
user because first there exist non-visual media with what they think should qualify as avatars as
well as that there are ways to present even visual avatars non-visually. They also acknowledged that
their definition is very broad but justified this by saying that their definition is meant to serve as
an umbrella for more specialised definitions. One drawback which they also acknowledged is that
they defined avatars as purely digital. It therefore excludes all analog and real life forms of avatars.
However for this thesis this drawback is acceptable as it is mainly concerned with avatars in VR
which is a purely digital medium.

3.1.1 Self-Avatar

The term “self-avatar” is used throughout the literature but always in a way which suggests it is
a well-known or completely self-explanatory term. Because of this it is hard to find a definition
of it, but there exists a definition in two papers by Pan and Steed [PS19] [SPZS16]. According
to those definitions a self-avatar is “a virtual representation of a body that is depicted from the
first-person perspective of the user’s eyes” [SPZS16, p.1]. Therefore a self-avatar is a user’s very
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own avatar which, because of the first-person perspective, perfectly replaces the users own body
visually. This has several effects on the user like increasing their immersion into the virtual world
which is explored in Section 2.1.1, improving the user’s ability to do certain tasks [SPZS16],
the user’s sense of self-location [PS19], their ability to estimate distances [CT10] and improving
their general enjoyment [LSG+16]. When everyone has a self-avatar it additionally helps users to
perceive, localise, identify and interact with each other [PS17].

3.1.2 People with Disability and their Avatars

Being disabled carries a certain negative stigma with it while being not disabled does not [Gru16].
Therefore it is understandable when people with disability choose to not disclose their disability to
the world at every possibility. For avatars this is possible because they can be customized to a users
liking making it easy for people with disability to not having to disclose their disability. This ability
to create non-disabled avatars is also useful for people who are disabled but do not see themselves
as such. Also by creating a non-disabled avatar people who do not see themselves as disabled can
represent themselves to others like they see themselves [Bar10] [SHC10]. By allowing people with
disability to not disclose their disability they are also enabled to do activities they can not do in
real life [SHC10]. On the other hand people who see themselves as disabled and want to share
this information with everyone else should have the ability to do so. In many applications it is not
possible to create an avatar with disability, so even if a user wants to be represented by a disabled
avatar they do not have the ability to do so. Some applications allow creating avatars with a visible
disability like for example VRChat1, however creating an avatar is not a trivial task in VRChat (see
section 4.1). Also the relationship one has with their avatar also works in the opposite direction and
can change ones behaviour and self-image [YB07]. This in turn can lead to one performing certain
tasks better [GSQ14a] depending on how ones avatar looks like.

Avatars can not only be used inside virtual environments. While they can look and behave more
realistic in virtual environments there also exist concepts using robots as real life avatars. One
such example is ‘OriHime-D’ by Takeuchi et al. [TYY20] which acts as a proxy for people with
disability to act as a server in a café. OriHime-D’s design is robotic but is designed in such a way
to not be perceived as threatening. In order to accomplish this it is 1.18 meters short and only
has basic human features as in a body with two arms and a skirt and a head with a very abstract
representation of a human face.

3.2 VR for People with Disabilities

VR hardware design is mostly ableistic in its nature and by this presents significant usability
problems for people with disability [GS21]. Mott et al. [MTK+20] have explored this topic deeper
by interviewing people with disability with and without prior VR experience on their opinions on
its accessibility. The participants voiced concerns about the initial setup, using the head mounted
display and being able to interact with the virtual environment through their controllers. This is

1hello.vrchat.com
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3.3 Effects of having an Embodiable Avatar

unfortunate because not only does this exclude a lot of people from using VR for entertainment but
VR has also been shown to have benefits for people with disability outside of just entertainment as
explored in Chapter 2.

3.3 Effects of having an Embodiable Avatar

A self-avatar first and foremost acts as a proxy for the user through which they are able to interact
with the virtual environment. In the case of VR it can be as simple as a virtual representation of the
controllers to fully modelled bodies. In order for a user to embody an avatar it is best if the user
has a first person perspective because they associate this type of view with how it is in their own
body. The more of the body is modeled and can be controlled by the user the more the user can
embody this avatar as already explored in section 2.1.4 and they will likely embody their avatar
[WGR+18] even if the avatars are not human [KCEK19]. Because the self-avatar acts as a frame of
reference for the user it is important to have a self-avatar in certain situations. Yu et al. [YAM+20]
for example found that for motion guidance a self-avatar with a first person view is the best option
for most motion guidance tasks.

However since users feel like they are their self-avatars, social interactions with others are no longer
from avatar to avatar but from person to person. It is therefore possible for insults aimed at or based
on the avatar’s appearance to be perceived by the user as an insult to them. Even virtual violence
done to an avatar which up until now can not be felt by the user can have a damaging effect on them
[Wol07].

Collingwoode-Williams et al. [COGP21] found that for different social dynamics different avatars
are beneficial for the interaction. Since it is the same in real life with different social interactions
requiring different appearances combined with that virtual worlds should not be treated as completely
separate from real life [Wol07] suggests that it should be made easy for the user to change their
avatars appearance. To this Collingwoode-Williams et al. [COGP21] also found that trust towards a
person in a more powerful social position increases if this person has a more abstract avatar, while
Hinrichs [Hin] found that for collaboration a more abstract avatar also improves trust between the
collaborators. However George et al. [GEHH18] found no difference in trust towards a person in a
more powerful social position regardless of if they had a robot or a human avatar. Additionally
they found that participants felt more comfortable if the other avatar also was a human instead of a
robot.
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4 Exploring Inclusive Avatar Design

In order to identify to which extent users have the ability to create avatars with disability at the time
this thesis was written, the first part of this section explores which possibilities are offered to a user
by several different avatar creation tools. The second part of this section contains the results of a
survey about peoples past usage and thoughts on avatars with disability.

4.1 Possibilities of Existing Avatar Creation Tools

A user’s ability to represent themselves within an application is limited by the possibilities the
application’s avatar creator provides. This makes it necessary for this thesis to investigate the
currently existing possibilities of such avatar creators to determine to what extend it is possible for
users to create avatars with visible disabilities. This exploration looks at avatar creators in video
games, social VR and some other applications.

Many games allow their players to customise the appearance of their character, their avatar. Looking
at the avatar creators of some well known action adventure games1 shows that, while they posse a
wide variety of customizability it is not possible to create an avatar displaying any significant form
of disability. The best, one might be able to achieve in that regard, is something similar to a Down
syndrome or blind eyes. This is probably only possible because both look very similar to having no
disability. A reason for this might be because those games make the player a fighter or adventurer.
Having an avatar that is disabled visibly in a significant way like sitting in a wheelchair would not
enable the player to have access to all the abilities they should have or appear to the player as to
unrealistic. People who are visibly disabled can still be dangerous foes as shown in another action
adventure game2 in which several capable foes sit in wheelchairs. In other game genres this is not
much different. Even games3 which have a very divers cast of characters do not give the player the
ability to create an avatar with any form of disability. This is probably again because having for
example a walking aid is too unrealistic in the games context. Some games however have started to
experiment with giving the player the option to have some level of visible disability in their avatar.
Some newly released games4 now give the player the option to replace (parts of) their avatar’s limbs
with prosthetics. This still stays true to not altering the avatar to much from a non-disabled state but
is definitely a step in the direction of avatars with disabilities.

For social VR platforms it looks a bit different. One of the most prominent social VR platforms is
VRChat. VRChat does not come with an avatar creator at all but is still examined here because
creating avatars is still a core part of it. It has some default avatars but none of them display any

1The Elder Scrolls V: Skyrim, Final Fantasy XIV, Dark Souls
2Bloodborne
3Stardew Valley
4Halo Infinite, Forza Horizon 5
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4 Exploring Inclusive Avatar Design

form of disability. For players to get new avatars, they can either use one designed and uploaded by
another user or create and upload one themselves. To do this the player must be able to use 3D
modelling software, know how to export the avatar correctly and know how to import it into the
game engine Unity5. Despite this approach giving the player absolute control over their avatars
design this does require a significant amount of skill from them. There are external tools with
which one can create an avatar for VRChat like Ready Player Me6 which makes it easy to create
non-disabled avatars. If a player however wishes to use an avatar with disability they still need to
model and upload it themselves although, because the human part of the avatar is finished, the
modelling is now much easier. SecondLife is another social platform even if it is not in VR which
allows its users to customize their avatars appearance. Avatars in SecondLife are different from those
in VRChat because the avatar and what they wear are treated as separate unlike in VRChat where
everything is combined into one. This makes it incredibly easy to change an avatars appearance by
changing for example their top or trousers or making them “wear” a wheelchair. However changes
to the actual body like for example an amputation demand a custom body requiring the user to either
change the actual appearance of their body or being able to use 3D software.

Looking at some of the top results when searching for “VR events” and “VR meeting tools”7 showed
that information about their avatar creators were almost non-existent. One of them had a very short
video showing their customization options which were very basic. It seems like creating avatars
with disability is not a possibility they offer.

In conclusion if one wants an avatar with disability they can either not create one at all, have only a
limited selection, or have it especially difficult because the selection of avatars with disability is
small. It seems however that implementing disability into avatar creators is slowly becoming more
commonplace.

4.2 Online Survey

The main contribution of this thesis is a survey which asked participants about their experiences
with and thoughts on avatars with visible disability. The main demographic of interest for this
survey were people with disability, but answers from non-disabled were also accepted. The survey
was conducted with the use of LimeSurvey. The questionnaire of the survey can be found in
Appendix A. Participants were recruited online via posts on Reddit and Twitter as well as emailing
several institutions which interact with people with disability on a regular basis.

4.2.1 Results

36 people successfully completed the survey but 1 person was removed because they misunderstood
the questions resulting in 35 completed answers. Of those 35 participants 23 had some form of
disability and 12 did not. Figure 4.1 shows where these participants were from. All participants
were WEIRD (western, educated, industrial, rich, democratic) with an equal split between European

5unity.com
6readyplayer.me
7Virtway Events, Next Gen Event Company, Event Farm
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Figure 4.1: Region of Origin of Participants
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Figure 4.4: Age at which participant’s disability
was diagnosed.

and North American participants overall, however the category of people with disability was skewed
towards Europe and consequently the category of people without disability was skewed towards
North America. The gender distribution across all categories was equal between male and female
with other genders being the exception as can be seen in Figure 4.2. The age distribution of the
participants was more on the young side as can be taken from Figure 4.3. Figure 4.4 shows that
many disabled participants experienced at least a part of their life without being disabled.

Of the participants with disability 17 had physical disabilities and 6 did not. Several participants
with physical disabilities also had cognitive disabilities but this was not the separation criterion.
Physical disabilities included but were not limited to cerebral palsy, amputation and epilepsy while
cognitive disabilities included but were not limited to autism, PTSD and depression. Participants
were also asked to specify the visible indicators of their respective disabilities. These indicators
ranged from not visible to purely movement related like poor posture or wrist flicking to body
altering. Since this thesis concerns itself with avatar design only the third category is of interest
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Figure 4.5: Importance of being able to create
disabled avatars in decision to use
application
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Figure 4.6: Frequency of disabled avatar usage
in video games

here. The indicators from this third category are: having tired eyes, wearing sunglasses and wide
brimmed hats and ear muffs, having visible scars, carrying a communication aid, wearing orthese,
using a walking aid or an (electric) wheelchair and having missing and/or deformed limbs.

In the first question regarding avatars with disability, participants were asked how important the
ability to create disabled avatars was in their decision to use an application which has this ability.
Figure 4.5 shows that this ability was mainly not important for both groups however it seems to
have been slightly more important for participants with disability.

Next participants were asked how often they have used disabled avatars in different situations. As
can be taken from Figure 4.6 in video games not many participants used disabled avatars. For
tabletop games like for example Dungeons and Dragons Figure 4.7 shows that while only few
participants with disability used disabled avatars, more participants without disability decided to
use them. However among those who have used avatars with disability, disabled participants seem
to have used them more often. For virtual business events Figure 4.8 shows that disabled avatars
are basically non existent in this field. Even in social virtual environments like those provided
by VRChat or SecondLife disabled avatars are more on the rare side as can be seen in Figure 4.9.
Some events nowadays already are offered completely virtually, some of them even inside a social
virtual environment meaning that participants can attend them with their own avatars. However as
Figure 4.10 shows among these participants basically no one had a disabled avatar for these events.
Lastly Figure 4.11 shows that even outside of the five previous categories the participants did not
really use avatars with disability.

When asked why they chose to use a disabled avatar 4 out of the 17 physically disabled participants
answered, it was to better represent themselves with 1 of those 4 stating they were also interested in
exploring the possibilities provided to them; 1 out of the 6 participants with only a mental disability
stated it was for backstory reasons for their character in Dungeons and Dragons. Participants were
also asked why they did not choose to use disabled avatars. Of the 17 participants with physical
disability 7 answered that the option was missing and 4 participants said they did not want to create
a disabled avatar with 1 of them stating that when they play video games they want to escape
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Figure 4.7: Frequency of disabled avatar usage
in tabletop games
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Figure 4.8: Frequency of disabled avatar usage
at virtual business events
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Figure 4.9: Frequency of disabled avatar usage
at virtual social environments
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Figure 4.10: Frequency of disabled avatar usage
at virtual events

reality and do not want to be reminded of their real life disability. One participant mentioned that
because they do not have a visible disability creating such an avatar would not represent them
and another participant additionally said that their disability is only sometimes visible, probably
implying that like for the other participant a visibly disabled avatar does not represent them. Another
2 participants did not realize creating an avatar with a visible disability was an option. Also 3
participants mentioned that they did not need to create avatars and therefore did not create any
disabled avatars. Of the 6 participants without physical disability 3 mentioned that the option was
not available and 1 participant did not want to create a disabled avatar because it “[s]hows self as a
target” [Participant 10]. Two participants stated that even when given the option they did not create
a disabled avatar because their disability is invisible. And 1 participant criticised that giving an
avatar a disability is a purely cosmetic change and does not alter the game’s mechanics.

27



4 Exploring Inclusive Avatar Design

Rarely Very often
0

5

10

15

20 19

3

0 0
1

11

1
0 0 0

N
um

be
ro

fP
ar

tic
ip

an
ts

Disabled Non-Disabled

Figure 4.11: Frequency of disabled avatar usage
for other activities
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Figure 4.12: Frequency of having seen disabled
avatars

Of the 12 non-disabled participants 3 answered that the option to create avatars with disability
was not available and 6 said they did not want to create a disabled avatar because it did not fit the
character they were designing, they did not want to misrepresent, this was not how they identify and
because it felt weird. One participant also added that even if they were disabled they would like to
keep this private. Finally 2 participants also mentioned that designing applications around avatars
with disability can be difficult.

Also when asked in which situations they would not want to use a disabled avatar only 3 out of
the 17 participants with disability and only 1 out of the 6 participants without physical disabilities
answered. These situations are playing with random people, at work, in a dating app or in general
when one wants to represent themselves.

Figure 4.12 shows how often participants had seen an avatar with disability which seems to be a
somewhat common occurrence. The reactions of the participants towards avatars with disability
seem to be non-negative as show in Figure 4.13. When asked where they had seen those avatars
the answers were mainly on social VR platforms. Interestingly mostly non-disabled participants
answered this question.

The last question in the survey asked the participants how much they agree with several statements.
First was if they would like to use avatars with disability to which the answers are found in
Figure 4.14. Both groups tend towards being undecided however some disabled participants would
like this ability. The follow-up statement to this was if the participants would use disabled avatars
if there were more people using them. As can be taken from Figure 4.15 the responses remained
almost identical to the previous statement. Using avatars with disability to see the world from a
different point of view was not an attractive idea for non-disabled participants, see Figure 4.16.

Changing the subject from using avatars with disability to occupying a virtual space with them
Figure 4.17 shows that most participants would be not opposed to seeing more disabled avatars. And
basically everyone would interact with a disabled avatar as can be taken from Figure 4.18. Disabled
people can be perceived as less capable meaning that in a competitive setting like competitive
multiplayer games there is the possibility that they might be perceived as a hindrance to their own
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Figure 4.13: Reactions to seeing disabled
avatars
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Figure 4.14: Participants agreement with the
statement ‘I want to use avatars
with disability.’
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Figure 4.15: Participants agreement with the
statement ‘I would use disabled
avatars if more used them.’
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point of view.’

29



4 Exploring Inclusive Avatar Design

Disagree fully Agree fully
0

2

4

6

8

10

0 0

7
6

10

1
0

3
4 4

N
um

be
ro

fP
ar

tic
ip

an
ts

Disabled Non-Disabled

Figure 4.17: Participants agreement with the
statement ‘I want to see more
avatars with disability.’
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Figure 4.18: Participants agreement with the
statement ‘I would interact with
a disabled avatar.’
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Figure 4.19: Participants agreement with the
statement ‘I would use a disabled
avatar in a competitive setting.’
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Figure 4.20: Participants agreement with the
statement ‘I would make the worlds
I create more accessible to avatars
with disability.’

team or an easy target for the enemy team. With this in mind participants were asked if they would
still use a disabled avatar in a competitive setting. The results in Figure 4.19 however are very
similar to those in Figure 4.14 which was only concerned with general use of disabled avatars
suggesting there is no real difference.

The last two statements were aimed at the participants thoughts on accessibility features in virtual
worlds. The first statement put the participant into the role of someone creating a virtual world
and asked them if they would add accessibility features for avatars with disability like for example
ramps for wheelchairs. Figure 4.20 shows that basically all participants were in favour of this idea.
However when they were asked to actually use these accessibility features in the second statement,
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Figure 4.21: Participants agreement with the
statement ‘I would use accessibility
features in worlds with a disabled
avatar.’
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Figure 4.22: Participants usage of VR.
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Figure 4.23: Participants frequency of VR us-
age.

participants were slightly more hesitant if they would use them as seen in Figure 4.21.

Because avatars can have a big impact on ones VR experience, participants were also asked about
their usage of VR. Of interest here was how many participants used VR, how often they did it and
what their reasons were for not using it. Figure 4.22 shows how many participants used VR. For
participants with disability using VR seems very unattractive with about half of them not even
having used it once and a quarter of them having stopped using it. This is in stark contrast to the
non-disabled participants were more than half of them are actively using VR. However the usage
frequency among those using VR in Figure 4.23 seems similar. Being asked for their reasons to
not use VR, 7 of the disabled and 2 of the non-disabled participants answered it was to expensive.
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Furthermore 7 disabled and 1 non-disabled participant stated their missing interest in the technology
and the applications offered for it and additionally 2 of the disabled participants who have stopped
using it said they got bored with VR. Finally 2 disabled and 1 non-disabled participant said it made
them feel worse.
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5 Discussion

After the survey this section now discusses potential implications the results of this survey and the
initial exploration into avatar creators might have. It also lists some limitations with the survey at
the end.

5.1 Virtual Reality

VR provides a unique experience for its users as it lets them embody an avatar. Because of this
the user not only controls the avatar but the avatar also has influence on the user’s behaviour and
self-image [YB07] [BGS13] [KBS13] [PSAS13]. It has even been shown to improve a motor
disabled persons coordination [GSQ14b]. However at least among the disabled participants the
usage is rather low. As Figure 4.22 shows, only half of them have even tried VR and only a quarter
still uses it. This seems to be in stark contrast to the non-disabled participants. However as the free
text answers show, it is also probable that there just happened to be many non-disabled VR users.
This may be because the biggest reasons against VR were that it is too expensive and a general lack
of interest in it. Only 2 disabled participants said it made their conditions worse compared to 1
non-disabled participant, so this does not seem to be a widespread issue. But among those using
VR the usage frequency seems similar suggesting that being disabled may not be a reason to not use
VR regularly.

5.2 Disabled Avatar Usage

Speaking of the avatar influencing its user [YB07] the non-disabled participants opinion on using
disabled avatars to experience the world from a disabled person’s point of view was low. This
disinterest in using avatars with disability is also represented in the answers shown in Figure 4.14
and the importance of being able to create disabled avatars shown in Figure 4.5. Only some
non-disabled participants would use disabled avatars, with most being against it and a third being
undecided. This is likely due to them feeling uncomfortable using disabled avatars since as some
said they do not want to misrepresent. Alternatively it might also just be a lack of interest in
experiencing disability.

For participants with disability Figure 4.5 shows that being able to create avatars with disability is
more important than for non-disabled participants. However when asked if they would use disabled
avatars most of them were unsure if they would or would not. The number of disabled participants
who would use disabled avatars is definitely higher than for the non-disabled participants. This
suggests that there might be a sizable group of people who would appreciate being able to use
avatars with disability. However it is possible that this group is not that big. This is because about
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the same amount of participants said they would use disabled avatars as said they would not and
the amount of undecided people who may decide to use disabled avatars is hard do estimate. A
reason for this may be that some disabled participants do not see themselves as disabled [SHC10]
and therefore do not want to be reminded of their real life disability but rather want an escape from
it. This is entirely possible in this survey because as Figure 4.4 shows many disabled participants
experienced part of their life without a disability. Additionally there currently exists prejudice
against disability [Gru16] and disabled people might want to escape this, not be seen as different
but like everyone else.

5.3 The Role of Avatar Creators

However, to say this is the reason for the rather low usage of avatars with disability shown in
Figure 4.6 to Figure 4.11 is not correct. As the initial exploration in Section 4.1 shows the abilities
of existing avatar creators in regards to enabling the creation of avatars with disability is rather
limited.

Disabled avatar usage at virtual events and virtual business events was almost non-existent which
is reflected by the exploration in Section 4.1 where for these two types of applications it was not
possible to create disabled avatars. In video games and virtual social environments the usage of
disabled avatars was slightly higher which is also reflected in the initial exploration.

For video games there is a slight paradigm shift with avatar design towards more inclusive avatars
and for virtual social environments players are often given complete creative control over their
avatar. Interestingly though despite having complete control over their avatars appearance in virtual
social environments not a lot of people choose to use an avatar with disability. This may be due to
the high amount of skill required to create a 3D model or having to spend hours to look through
player made content in order to create the avatar one envisions. Therefore people might just choose
to use pre-made avatars or easily available avatar components which most of the time means using a
non-disabled avatar.

The highest amount of disabled avatars is found in tabletop games1. This is likely due to them
giving their players complete control over their avatars appearance without forcing them to create a
visual representation of their avatar as everything is only a spoken story. Also there is no central
authority telling anyone how to play enabling the players to craft their own experiences. The story
itself is also explicitly tailored to the players by their gamemaster, the player creating the story,
enabling them to adapt the game to every situation. And the groups that play together are often
friends or people who know each other so players with a disabled avatar do not have to worry about
any prejudice.

Of course not every piece of media can include disabled avatars because its specific setting might
not allow their use. For example video games with an action-adventure or medieval setting can not
really accommodate them as their gameplay and/or setting normally require the player’s avatar to be
able-bodied. But other applications like social VR or virtual business events are not limited by this.
Here providing options for disabled avatars might make people who identify as being disabled feel
more welcome.

1like Dungeons and Dragons
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5.4 Considerations for Disabled Avatar Design

There is also a discussion to be had about how disabled avatars are implemented. Is it enough for
the disability to be entirely cosmetic or should it change how an avatar behaves? This was noted by
one participant. This in turn raises the question of how disability would be implemented without
making it degrading and/or cumbersome to use as also noted by one participant. For example
should people who use a wheelchair in VR be able to move around like non-disabled people with
only the controller or should they have to make the motion of pushing their wheelchair or if they use
only the controller does the application take away control of their avatar’s arms to do the pushing
motion itself? Or is the wheelchair or similar a permanent part of an avatars model or are their
ways to remove them easily to for example sit or lie down?

5.5 Acceptance of Avatars with Disability

However despite the difficulties with creating avatars with disability Figure 4.12 shows that while
avatars with disability are uncommon to use, they are used often enough for many participants to
have seen them. Normalizing disabled avatars could be a way to increase their adoption. However as
Figure 4.15 together with Figure 4.14 shows the number of participants who would use avatars with
disability if they were more common is only slightly higher than those who would use one right now.
Interestingly, even though using a disabled avatar in a competitive setting might make a combatant
seem less capable and therefore be more likely targeted or perceived as a hindrance by their own
team, the number of participants who would still use an avatar with disability in this setting stays
consistent with those who would use a disabled avatar in the first place (see Figure 4.19). This
suggests that for participants who want to use a disabled avatar using a disabled avatar is more
important than the potential consequences.

The answers in Figure 4.17, Figure 4.18 and Figure 4.20 suggest that people are not opposed to
the idea of disabled avatars existing. The last one also shows that people would try to look out for
disabled users and try to accommodate them. This however should not go to far as this would end
in ableism which should be avoided. The number of participants who would actually use these
accessibility features is however a lot lower than those who would add them to their worlds for
disabled as well as non-disabled participants. This does suggest that given the opportunity to not
having to use a more accommodating but also more cumbersome design like in virtual environments
people will do so. Going back to a previous Section 5.4 this would mean that in order to control
the wheelchair users should be allowed to only use the controller and not be forced to make the
actual pushing motion. Additionally people are not only not opposed to disabled avatars existing,
Figure 4.13 also shows that participants did not react negatively to seeing an avatar with disability.

5.6 Conclusion

All of this suggests that there should be no real opposition to having avatars with disability in an
application if they fit thematically. However the actual usage of such avatars might be rather low and
will definitely not reflect the real world distribution of disabled to non-disabled people. This needs
to be accepted as not everyone wants to show their disability if they do not have to and they should
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not be forced to. Therefore most people are likely to continue to use non-disabled avatars, reducing
the importance of adding disabled avatars, making it potentially a low priority for companies to add
to their applications.

5.7 Limitations

This thesis acknowledges that the questions about disabled avatar usage in the survey could have
been formulated better by changing the wording of one of the answer options from “Rarely” to

“Never” and giving the participants an option to state that they have never used a certain type of
application. This would have resulted in a more accurate depiction of disabled avatar usage among
those who actually used these applications. Furthermore it is probable that some of the answers are
not entirely the participants actual thoughts but are skewed to conform more to societal norms, in
this case mainly to not appear exclusive against people with disability.
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Among the survey’s participants there seems to be a general interest in having avatars with disability.
However some questions arose from the survey:

• How comfortable are people with disabled avatars around strangers?

• Are they more comfortable around people they know/friends?

• Are the reactions of others really overwhelmingly positive?

• Would people actually use a disabled avatar in a competitive scenario?

• Is there a difference in the acceptance of avatars with disability between VR and non-VR?

• How should avatars with disability be implemented?

The first two questions and the third question in part were supposed to be explored in a user study as
part of this thesis however due to the studies size and time constraints this did not happen. The
explanation for this is found in Section 6.4. Therefore the goal for the thesis was changed from
conducting this study to only prepare it as a followup study.

6.1 Apparatus

Since VR offers the possibility of the most immersive and present experience it is preferable to use a
VR environment for this study. This makes sure participants do not tolerate as much inconvenience
just for the sake of the study as it is harder for them to feel separate from their avatar. The VR
environment also needs to have a sufficiently large amount of players in order for participants
to come into contact with many strangers and be independent from the researchers so the time
participants spend inside the VR environment is not limited by the researchers time. It also must
have the ability to create and use avatars with disability. For these reasons VRChat1 is chosen as a
platform to conduct the study in. VRChat is a VR environment with around 25,000 active daily
users2 and the ability to upload self-made avatars.

The study consists of two parts. In the first part participants are asked to use avatars having signs
of disability in VRChat. These signs of disability are based on a participants real life signs of
disability, e.g. if a participant uses a wheelchair in real life their provided avatar would also have
a wheelchair. The possible signs are a wheelchair, a walking cane, a walker, an amputation or a
prosthetic. For this 3D models of these signs are created beforehand which are then combined with
the 3D models of non-disabled avatars inside a 3D modelling software to create an avatar with signs

1hello.vrchat.com
2steamdb.info (April 2nd, 2022)
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of disability. A detailed technical walk-through for creating these avatars is found in Appendix B.
The avatars should look similar to their corresponding participants to improve the participant’s
presence [WGR+18] [LSG+16]. Then these now disabled avatars are provided to the participants by
the researchers. This is either done by providing the participant with an fbx file or a Unity3 package
to upload the avatars themselves or they can copy the avatars from a private world inside VRChat.
This world contains avatar pedestals4 from which the participant can copy their avatars. A private
world is different from a private instance of a public world in that in order to join it the creator has
to specifically invite a user otherwise they are inaccessible. Creating a private world is possible
by not making a request to the VRChat team to make an uploaded world publicly accessible. In
order to upload anything to VRChat the uploader needs to have Unity installed and import either the
VRChat Avatar SDK or the VRChat World SDK5 package. These do not work with every version of
Unity so the uploader must make sure they have a compatible version. Participants are free to use an
avatar having no signs of disability. Every week the participants are asked to fill out a questionnaire
about their experiences in this past week. This is supposed to provide the interviewer with topics
they can then ask for more details about. For this first part the participants are also asked to only
use VRChat with a VR setup.

The second part of this study is an interview held as either a personal interview or as a focus group
with several participants. These interviews are semi-structured held inside a private instance of a
VRChat world representing a meeting room. Alternatively an external option can be offered to the
participant should they not wish to do the interview inside VRChat. This interview is recorded
for later transcription; the recording is deleted afterwards. The guiding questions for the interview
are:

• How often did they use an avatar with disability compared to one without?

• In which situations were they comfortable with using an avatar with disability?

• In which situations were they not comfortable with using an avatar with disability?

• What were the reactions of their friends?

• What were the reactions of strangers?

• Would they want to continue using an avatar with disability?

• What are their reasons for (not) continuing to use an avatar with disability?

To keep personal data which needs to be removed to a minimum each participant is assigned a
unique identification number (ID). This ID is chosen randomly to make sure participants do not
identify as another participant.

3unity.com
4docs.vrchat.com/docs/vrc_avatarpedestal
5docs.vrchat.com/docs/setting-up-the-sdk
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6.2 Procedure

Figure 6.1: Avatar with different identifiers of disability. From left to right: walking cane,
wheelchair, wheeled walker. The hands were left open intentionally. The avatar itself
was created with Ready Player Me.

6.2 Procedure

After recruitment participants are asked to provide an avatar which will then be augmented with
one or several signs of disability. The participants can either provide an existing avatar of theirs or
if they have none create one either themselves or through the use of an avatar creator, e.g. Ready
Player Me6. They must provide a fully rigged 3D-model; if they do not have such an avatar, the
avatars generated by Ready Player Me are fully rigged and can therefore be used to complete this
step. Certain details of the augmented avatars may need to be discussed with each participant
individually. They can then decide if they want to get their avatars as an fbx file or a Unity package
to upload the avatars themselves or if they want to copy them from a private avatar sharing world
inside VRChat.

The participants are then asked to use VRChat several times over at least the next two weeks and
to use their avatars with disability as often as they feel comfortable with. Additionally they are
asked to fill out the weekly questionnaire. Afterwards each participant is asked to take part in an
interview session. These sessions are either held as a solo interview or a focus group based on the
participants preferences. Participants are free to keep their avatars afterwards and are reimbursed
with US$20 but only if they successfully participated in the whole study.

6e.g. readyplayer.me
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6.3 Participant Recruitment

This study wants to explore how people with disability feel using avatars with disability. This
demographic is chosen because people with disability are likely to be the main user group of
disabled avatars. Since this study utilises VRChat and does not require the participants to be present
onsite, participants can be from all over the world. To reach as many participants as possible
recruitment can be performed entirely virtually inside and outside of VRChat. Outside recruitment
can be done on Reddit7 or Discord8 or on Twitter. Inside recruitment however is more difficult and
relies on finding the right groups of people inside VRChat and getting people to share the study
among themselves. Both approaches should be used to reach as many potential participants as
possible.

6.4 Challenges with performing the Study

The study was started while this thesis was still ongoing as at least partial results were planned
to be included here. At the time of writing of this thesis around 25 people answered the call for
participation. Of these 4 were selected to be part of this thesis and all participants were supposed to
be part of a follow-up paper. However out of the 4 participants for this thesis none either understood
or wanted to actually participate in the study. When asked to upload their avatars they chose to
upload random images and videos. After being reminded to please upload 3D-models of their
avatars and that if they did not have one to use Ready Player Me to create an avatar, they all uploaded
a single image of the upper body of a default avatar provided by Ready Player Me with only one or
two changes. Due to time constraints and their general lack of interest in the study, the study was
dropped from this thesis with approval of the supervisors. Out of all possible participants only 1
uploaded a 3D-model with the rest being similar to the 4 participants described above.

7e.g. r/VRChat, r/DisabledGamers
8discord.gg/vrchat
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7 Conclusion and Future Work

This thesis explored the concept of avatars with disability. For this it first examined some background
to VR, immersion and presence and specified which disabilities it considers important for the topic
of avatars with disability. It then reviewed some related work to avatars before examining the
capabilities of already existing avatar creation tools. This was followed by an online survey which
explored peoples thoughts on avatars with disability and their VR usage.

In Chapter 3 the thesis found that there is a lack of research regarding avatars with disability.
There are some papers examining disabled peoples experience and problems with technology; in
the context of this thesis specifically problems with VR technology. Others have examined the
opportunities presented to people with disability by virtual environments, mainly that they can free
people from their disability or allow them to experience and do things they would normally not
be able to do because of their disability. A few papers are actually concerned with avatars with
disability but only in some very niche applications like how they can help in rehabilitation and not
with their everyday use. The thesis also found that the term “Self-Avatar” is not well defined and
defined it as ones own avatar for itself.

The lack of avatars with disability is also present in several of the biggest current applications which
allow for or are exclusively focused on the creation of avatars. While some applications may choose
so because of thematical reasons like a medieval setting others like virtual events are not limited
by this but still do not have avatars with disability. Some applications allow their users to upload
custom avatars and by this do theoretically support avatars with disability. However this can be
difficult if one needs to be able to 3D model in order to create their avatar as 3D modelling presents
a big barrier of entry. There exist some outside resources which can create a 3D avatar for one but
they are also unable to create avatars with disability. Some video games have started to incorporate
disability into their avatar creators however only in a very limited way. They are mainly focused on
keeping the avatar as close to non-disabled as possible, so the options are limited to e.g. (partial)
blindness or prosthetic limbs. These are definitely signs of disability but they do not really alter the
body compared to a non-disable avatar visually. The survey’s results to tabletop games seem to
suggest that if it is easy to create avatars with disability and one is provided with a environment in
which they feel comfortable with using a disabled avatar more people will use them.

In the survey participants were asked first and foremost about their thoughts on avatars with disability.
Of special interest here were the thoughts of people who live with disability. Most participants
were not really interested in using disabled avatars themselves. Reasons for this may include but are
not limited to not wanting to present oneself as a target to others, not identifying as being disabled
and not wanting to be reminded of being disabled. However basically no one was against the idea
of having the option to create an avatar with disability for those who want to and even considered
adding accessibility features like ramps to their virtual worlds to accommodate them. But when
it comes to using these accessibility features less people were ready to do so as virtual worlds do
not present the same limitations to accessibility as the real world. This in turn highlights another
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point namely that if it is more cumbersome to use an avatar with disability compared to one without
less people will decide to do so. All of this does suggest that more people would use avatars with
disability if they had the opportunity to. There also does not seem to exist any real opposition to
having this option for those who want it.

Since using VR can have positive effects especially for people who do not identify as being disabled
through the Proteus effect [YB07] it was surprising to see so few people with disability are using it.
However being disabled seemed not to be the primary factor for not using VR instead it was the
price and a lack of interest in the technology. This does not directly support other research which
has found that concerns about being able to use the technology without help was a big barrier for
motor impaired people [MTK+20] but also does not really contradict it either.

7.1 Future Work

First is the study described in Chapter 6 which will be conducted by the supervisors of this
thesis. This study is however only a first exploration into using avatars with disability in everyday
applications and should be extended more. Possibilities for this would be expanding it to other
areas, e.g. business meetings, and comparing the results to the study, find how big the impact of the
Proteus effect [YB07] is, and if there is a difference between VR and non-VR. Furthermore since
there are so few opportunities to create avatars with disability it would be interesting to see if given
the opportunity, how many people would choose this option and additionally if they would do so in
a competitive scenario. It should also be investigated what people think about having avatars that
stray further from a non-disabled body by for example amputating limbs or adding accessories like
a wheelchair. This then raises the question whether it is enough for the disabilities to be purely
cosmetic or if they should also entail some mechanical differences. Moreover this thesis only asked
people for their opinion which is prone to biases and should be reinforced with an experimental
study.
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A Survey - How prevalent are disabled avatars?

These are all the questions and answer options participants were presented with in the survey.
The survey was available in English, German and Easy German but only the English version is
listed here. The survey consisted of four pages, herein represented by the different sections, plus a
welcome page and an end page which are omitted from this appendix. Some pages started with
definitions to make sure participants understood used terms as they were intended. If a question had
answer options those are provided together with the question. Mandatory questions are marked with
a star (*). Participants did not see all questions because some did not apply to them. The condition
for a question to be shown will be written after it in brackets.

A.1 Demographic Information

Definitions:

• Signs of disability are for example

– sitting in a wheelchair

– a missing limb

– signs from other disabilities

Questions:

• Which country are you from?

• How old are you?

• What is your gender? *

– Male

– Female

– Other

– Prefer not to say

– Prefer to self-describe

• Do you have a disability or some form of impairment? *

– Yes

– No

– Prefer to not say
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A Survey - How prevalent are disabled avatars?

• What disability do you have? (Participant was disabled.)

• What are the visible signs of your disability? * (Participant was disabled.)

• How old were you when your disability was diagnosed? (Participant was disabled.)

A.2 Applications

Definitions:

• Avatar: An avatar is an entity created by yourself to represent you within and interact with a
digital environment.

• VR: Short for "Virtual Reality". To use VR you need a headset which completely blocks your
view of the outside world.

• Visible, physical disabilities are for example

– sitting in a wheelchair

– a missing limb

– signs from other disabilities

Questions:

• Do you use VR or have you used VR in the past? *

– I do.

– I did.

– I do not and have never used it.

• How often do you use VR? * (Participant used VR.)

– Daily

– Several times a week

– Several times a month

– Several times a year

– More rarely

• Why do you not use VR? (Participant does not use VR.)

• Please list all VR applications, that you know, in which you can create an avatar with visible,
physical disabilities.

• Please list all non-VR applications, that you know, in which you can create an avatar with
visible, physical disabilities.

• How important was the ability to create an avatar with visible, physical disabilities for you to
use these applications? *
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A.3 Avatars with visible Disabilities

– 1 - Completely unimportant

– 2

– 3

– 4

– 5 - Very important

A.3 Avatars with visible Disabilities

Definitions:

• Avatar: An avatar is an entity created by yourself to represent you within and interact with a
digital environment.

• Visible, physical disabilities are for example

– sitting in a wheelchair

– a missing limb

– signs from other disabilities

Questions:

• How often have you used an avatar with visible physical disabilities in... *

– Situations:

∗ ...Video games

∗ ...Virtual Social environment (eg. VRChat, SecondLife)

∗ ...Virtual events (eg. concert)

∗ ...Work (eg. virtual conference)

∗ ...Tabletop games (eg. Dungeons and Dragons)

∗ ...Other

– Answer options:

∗ Very often

∗ Often

∗ About half of the time

∗ Sometimes

∗ Rarely

• Why did you decide to use an avatar with visible, physical disabilities? * (If participant used
such an avatar in any of the above scenarios at least half of the time.)
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A Survey - How prevalent are disabled avatars?

• Why did you decide to not use an avatar with visible, physical disabilities? * (If participant
used such an avatar in any of the above scenarios at most half of the time.)

• In which situations or applications would you not want to use an avatar with visual, physical
disabilities.[sic] (If participant used such an avatar in any of the above scenarios at least half
of the time.)

• How often have you seen an avatar with visible, physical disabilities? *

– Very often

– Often

– Sometimes

– Rarely

– Never

• Please list all applications in which you have seen an avatar with visible, physical disabilities.
(If participant saw disabled avatars at least rarely.)

• What was your reaction to seeing an avatar with visible, physical disabilities? (If participant
saw disabled avatars at least rarely.)

– I want that, too.

– Cool they could do that.

– Neutral

– Why is this even possible?

– This needs to be removed now.

• Please rate how much you agree with the following statements. *

– Statements:

∗ I would also consider using an avatar with visible, physical disabilities, if more
people used an avatar with visible, physical disabilities.

∗ I want to see more avatars with visible, physical disabilities.

∗ I want to use an avatar with visible, physical disabilities.

∗ I would use an avatar with visible, physical disabilities to see the world from a
disabled persons view.

∗ I would use an avatar with visible, physical disabilities in a competitive setting.
Such an avatar might be considered less capable.

∗ If I were to meet an avatar with visible, physical disabilities, I would interact with
them.

∗ Imaging yourself using an avatar with visible, physical disabilities. I would use
accessibility features even though I do not have to, e.g. using ramps with a
wheelchair instead of the stairs.
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A.4 Miscellaneous

∗ Imaging yourself being the creator of a virtual world. If there were more avatars
with visible, physical disabilities, I would make the world accessible for those
avatars, e.g. by installing ramps.

– Answer options:

∗ I agree fully

∗ I agree somewhat

∗ I am undecided

∗ I disagree somewhat

∗ I disagree fully

• Why do you not want to use an avatar with visible, physical disabilities? * (If participant
selected ‘I disagree somewhat/fully’ at statement ‘I want to use an avatar with visible, physical
disabilities.’)

A.4 Miscellaneous

Questions:

• If you want to tell us something else about avatars with visible, physical disabilities which
did not fit to any of the previous questions, please do that here.

• If you want to tell us something else, please do that here.
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B Creating the Avatars for the followup Study

This appendix describes the process of creating the avatars with disability for the described followup
study in detail.

B.1 Creating the Signs of Disability

First a wheelchair, a walker and a walking cane were modeled using Blender1, see Figure 6.1 for
reference. Having an arm and a leg prosthetic was also planned but since the study was removed
from this thesis this was not done as part of this study. The models were manually uv-unwrapped to
create clearly structured textures. This was done by switching to “Edit”-Mode and marking every
edge which should be separated for the uv-unwrap as “Seam”. Then the model was uv-unwrapped
by selecting “UV→Unwrap”. Also all vertices were assigned to a single vertex group.

All models had Blenders procedural materials for colouring which had to be baked into textures to be
used in VRChat. For this Blender’s render engine had to be switched to “Cycles”. To every material
which was attached to the model a new texture node had to be added in which the output texture
was selected. Before baking it had to be made sure that this texture was the actively selected one if
the material contained at least one other texture node. Then under “Render Properties→Bake” the
settings for the baking process were configured before clicking on bake. For the colour texture the

“Bake Type” was set to “Diffuse” and under “Influence→Contributions” only “Color” was selected.
Then the roughness texture was baked by setting the “Bake Type” to “Roughness”. Before baking
the roughness map, it was made sure all “Metal” contributions to the texture were set to 0. For the
metal texture the “Bake Type” was set to “Emit”. This was done because at the time of writing this
thesis it was not possible to directly bake the metal texture due to a bug. Therefore all “Metal”
contributions had to be set for the “Emit” property of the material instead. A normal map was
also baked despite it being unnecessary, as there was no higher quality model, by setting the “Bake
Type” to “Normal”. After each bake the produced texture were saved manually. Afterwards all
Materials were replaced with a single new material for the whole model which had only the baked
textures set to the corresponding inputs of the “Principled BSDF” shader.

The model could now be exported as an fbx file to be imported into a project with the avatar to be
modified. Alternatively the modeled could also be added to this new project directly from the blend
file.

1blender.org
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B Creating the Avatars for the followup Study

B.2 Modifying the Avatars

The avatars were imported into a project via “File→Import→<File Type>”. The sign(s) of
disability were either imported as an fbx file via “File→Import→FBX (.fbx)” or by appending
them directly from their blend files via “File→Append” then selecting the correct blend file and
from this selecting the correct model. The signs of disability were then moved, scaled, and rotated
to fit the avatar. All transformations were then applied via “Object→Apply→All Transforms”.
Then an armature modifier was added to the sign of disability via “Modifier Properties→Add
Modifier→Armature”. The “Object” property of this modifier was set to the armature imported
with the avatar, the “Vertex Group” modifier to the vertex group of the sign of disability.

The sign of disability then needed to be weight painted so it would move with the armature. For this
first the armature then, while holding the “Shift” key, the sign of disability was selected so both are
selected and the sign of disability is the actively selected. The current mode of Blender was then
switched to “Weight Paint”. Here the base bone of the armature was selected by holding the “Ctrl”
key while selecting it. The base bone is normally the lowest bone of the spine. The “Weight” and

“Strength” selector were both set to 1.000 and the falloff to “Constant”. Then the entire model of
the sign of disability was painted until every vertex was red.

Switching back to “Object Mode” the meshes of the avatar and the sign of disability were now joined
with “Object→Join”. Finally the finished model was exported as fbx via “File→Export→FBX
(.fbx)”. Here all default settings were kept and “Apply Transform” was checked to make sure the
exported avatar was upright.

B.3 Import Avatars into Unity

Unity’s material system does not support roughness textures. Instead smoothness textures have to
be passed to Unity as the alpha channel of the metal texture. Smoothness is the inverse of roughness
therefore it is enough to simply invert the roughness texture to get a smoothness texture. This was
done in GIMP2. The metal texture of the sign of disability was opened in GIMP then the roughness
texture was imported as a layer via “File→Open as Layers”. The roughness texture was then
inverted via “Colours→Invert”. Then the “Layers” tab on the right was changed to “Channels”
and a selection was created from one of the channels via “right click→Channel to Selection”. Any
of the three colour channels can be chosen for this as the texture is black and white. The selection
was then inverted via “Select→Invert”. Switching back to the “Layers” tab an alpha channel
was added to the metal texture via “right click→Add Alpha Channel” because all textures were
created without alpha channel to save space. Then having the metal texture as the active layer the
alpha channel was cut out by pressing “Ctrl+X”. After making the roughness layer invisible by
clicking on the eye next to it the new combined metal and smoothness texture was exported via

“File→Export As...”.

In Unity the VRChat Avatar SDK was imported via “Assets→Import Package→Custom Package...”.
Then the avatar was imported via “Assets→Import New Asset...”. Then after selecting the newly
imported avatar in the “Project” view the materials were extracted via “Materials→Extract

2gimp.org
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Materials...” in the “Inspector” view. After selecting the material the combined metal and
roughness texture, which was also imported as a new asset, is then set as the metal texture. It must
was made sure that the source for the smoothness is set to “Metallic Alpha”. After the avatar model
was placed inside a scene in the “Inspector” view the “VRC Avatar Descriptor” component must
be added via “Add Component→VRC Avatar Descriptor”.

The VRChat SDK overlay should then allow the upload of the avatar. If the avatars are supposed to
be uploaded as part of an avatar sharing world, they must be placed on VRChat avatar pedestals.
However it never came to either of these steps so no instructions can be given on it.
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